
 

Unit 1 
Definition and overview of computer, computer classification, computer organization, computer code, input devices, output 
devices, storage devices. Computer software, types of software. overview of computer networks, LAN, MAN, WAN. Internet, 
network topology. Internetworking: Bridges, repeaters and routers. 

 

Digital computer: an electronic device which is capable of receiving information (data) in a particular form and of 
performing a sequence of operations in accordance with a predetermined but variable set of procedural instructions (program) to 
produce a result in the form of information or signals. A computer is a device that accepts information (in the form 
of digitalized data) and manipulates it for some result based on a program or sequence of instructions on how the data is to be 
processed. Complex computers also include the means for storing data (including the program, which is also a form of data) for 
some necessary duration. A program may be invariable and built into the computer (and called logic circuitry as it is on 
microprocessors) or different programs may be provided to the computer  

Block Diagram of Computer and Explain its Various Components: A computer can process data, 
pictures, sound and graphics. They can solve highly complicated problems quickly and accurately.  Performs 
basically five major computer operations or functions irrespective of their size and make. These are 
1) it accepts data or instructions by way of input, 

2) it stores data, 
3) it can process data as required by the user, 

4) it gives results in the form of output, and 

5) it controls all operations inside a computer. 

We discuss below each of these Computer operations 

 

 

1. Input: This is the process of entering data and programs in to the computer system. You should know that 
computer is an electronic machine like any other machine which takes as inputs raw data and performs some 
processing giving out processed data. Therefore, the input unit takes data from us to the computer in an 
organized manner for processing. 



2. Storage: The process of saving data and instructions permanently is known as storage. Data has to be fed 
into the system before the actual processing starts. It is because the processing speed of Central Processing Unit 
(CPU) is so fast that the data has to be provided to CPU with the same speed. Therefore the data is first stored in 
the storage unit for faster access and processing. This storage unit or the primary storage of the computer 
system is designed to do the above functionality. It provides space for storing data and instructions.  

      The storage unit performs the following major functions: 

• All data and instructions are stored here before and after processing. 
• Intermediate results of processing are also stored here. 

3. Processing: The task of performing operations like arithmetic and logical operations is called processing. 
The Central Processing Unit (CPU) takes data and instructions from the storage unit and makes all sorts of 
calculations based on the instructions given and the type of data provided. It is then sent back to the storage 
unit. 

4. Output: This is the process of producing results from the data for getting useful information. Similarly the 
output produced by the computer after processing must also be kept somewhere inside the computer before 
being given to you in human readable form. Again the output is also stored inside the computer for further 
processing. 

5. Control: The manner how instructions are executed and the above operations are performed. Controlling of 
all operations like input, processing and output are performed by control unit. It takes care of step by step 
processing of all operations inside the computer. 

      FUNCTIONAL UNITS: In order to carry out the operations mentioned in the previous section the computer 
  Allocates the task between its various functional units. The computer system is divided into three separate units 
for 
  its operation. They are 
 1) Arithmetic logical unit 
 2) Control unit. 
 3) Central processing unit. 
Arithmetic Logical Unit (ALU) Logical Unit 
 Logical Unit: After you enter data through the input device it is stored in the primary storage unit. The actual 
processing of the data and instruction are performed by Arithmetic Logical Unit. The major operations performed 
by the ALU are addition, subtraction, multiplication, division, logic and comparison. Data is transferred to ALU 
from storage unit when required. After processing the output is returned back to storage unit for further processing 
or getting stored. 
 Control Unit (CU) 
The next component of computer is the Control Unit, which acts like the supervisor seeing that things are done in 
proper fashion. Control Unit is responsible  for  coordinating various operations using time signal. The control unit 
determines the sequence in which computer programs and instructions are executed. Things like processing of 
programs stored in the main memory, interpretation of the instructions and issuing of signals for other units of the 
computer to execute them. It also acts as a switch board operator when several users access the computer 
simultaneously. Thereby it coordinates the activities of computer’s peripheral equipment as they perform the input 
and output.  
Central Processing Unit (CPU)  
The ALU and the CU of a computer system are jointly known as the central processing unit. You may call CPU as 
the brain of any computer system. It is just like brain that takes all major decisions, makes all sorts of calculations 
and directs different parts of the computer functions by activating and controlling the operations. 
Characteristic of a Computer 
1. SPEED : Computer is very fast calculating device. It can execute basic operations like subtraction, addition, 
multiplication and division at a few microseconds. It can move and copy data at a speed in the order of billion 
instruction per second. 
 2. ACCURACY : Computer always gives accurate results. The accuracy of Computer does not go down when they 
are used continuously for hours together. 
It always gives accurate results. 
 



 3. STORAGE CAPACITY: Computer has a very large storage capacity. A large volume of information can be 
stored in the memory of computer and information can be retrieved correctly when desired. 
 4. VERSATILITY: The working of computer with different types of data is known as versatility. That means 
computer can perform different types of job efficiently. Computer can works with different type of data and 
information such as visuals, text, graphics & video etc. So, versatility is a most important characteristic of 
computer. 
 5. DILLIGENCE: A Computer can work for long hours with the same accuracy and speed because it is free from 
problems of boredom or lack of concentration. 
Classification of Digital Computers: 
The digital computers that are available nowadays vary in their sizes and types.  The computers are broadly 
classified into four categories based on their size and type 
1. Microcomputers 
2. Minicomputers 
3. Mainframe computers 
4. Supercomputer 
1. Microcomputers: 
Microcomputers are small, low-cost and single-user digital computer. They consist of CPU, input unit, output unit, 
storage unit and the software. IBM PC based on Pentium microprocessor and Apple Macintosh are some examples 
of microcomputers. Microcomputers include desktop computers, notebook computers or laptop, tablet computer, 
handheld computer, smart phones and notebook,  
(a) Desktop Computer or Personal Computer (PC) - It is the most common type of microcomputer. It consists of 
three units—keyboard, monitor, and a system unit containing the CPU, memory, hard disk drive, etc. It is not very 
expensive and is suited to the needs of a single user at home, small business units, and organizations. Apple, 
Microsoft, HP, Dell and Lenovo are some of the PC manufacturers. 
(b) Notebook Computers or Laptop - They are portable and have all the features of a desktop computer. The 
advantage of the laptop is that it is small in size, can be carried anywhere. Laptops can be placed on the lap while 
working. Laptops are costlier than the desktop machines. 
(c) Notebook - These are smaller notebooks optimized for low weight and low cost, and are designed for accessing 
web-based applications. Notebooks deliver the performance needed to enjoy popular activities like streaming 
videos or music, emailing, Web surfing or instant messaging. 
(d) Tablet - Tablet Computer has features of the notebook computer but it can accept input from a stylus or a pen 
instead of the keyboard or mouse. It is a portable computer. Tablet computer are the new kind of PCs. 
(e) Handheld Computer or Personal Digital Assistant (PDA) - It is a small computer that can be held on the top 
of the palm. It is small in size. PDA uses a pen or a stylus for input, Instead of the keyboard. They have a limited 
memory and are less powerful. PDAs can be connected to the Internet via a wireless connection. Example Casio 
and Apple are some of the manufacturers of PDA. 
(f) Smart Phones - These are cellular phones that function both as a phone and as a small PC. They may use a 
stylus or a pen, or may have a small keyboard. They can be connected to the Internet wirelessly. They are used to 
access the electronic-mail, download music, play games, etc. Blackberry, Apple, HTC, Nokia and LG are some of 
the manufacturers of smart phones. 
2. Minicomputers 
Minicomputers are digital computers, generally used in multi-user systems. Minicomputers are mainly used as 
small or midrange servers operating business and scientific applications. They have high processing speed and high 
storage capacity than the microcomputers. Minicomputers can support 4–200 users simultaneously. The users can 
access the minicomputer through their PCs or terminal. Example Digital Alpha, Sun Ultra. 
3. Mainframe Computers 
Mainframe computers are multi-user, multi-programming and high performance computers. They operate at a very 
high speed, have very large storage capacity and can handle the workload of many users. Mainframe computers are 
large and powerful systems generally used in centralized databases. Computers with large storage capacities and 
very high speed of processing (compared to mini- or microcomputers) are known as mainframe computers. They 
support a large number of terminals for simultaneous use by a number of users like ATM transactions. They are 
also used as central host computers in distributed data processing system. Mainframe computers are used in 
organizations like banks or companies, where many people require frequent access to the same data. 
Examples: -    IBM 370, S/390. 



 
4. Supercomputers 
Supercomputers are the fastest and the most expensive machines. They have high processing speed compared to 
other computers. The speed of a supercomputer is generally measured in FLOPS (Floating point Operations per 
Second). Some of the faster supercomputers can perform trillions of calculations per second.  
Supercomputers are used for highly calculation-intensive tasks, such as, weather forecasting, climate research 
(global warming), molecular research, biological research, nuclear research and aircraft design. They are also used 
in major universities, military agencies and scientific research laboratories.  
Some examples of supercomputers are IBM Roadrunner, IBM Blue gene and Intel ASCI red. PARAM is a series of 
supercomputer assembled in India by C-DAC (Center for Development of Advanced Computing), in Pune. 
PARAM is the latest machine in this series. The peak computing power of PARAM is 1 Tera FLOP (TFLOP). 
 

Computer Organization 
(Central processing unit): Where decisions are made, computations are performed and input/output requests are 
delegated  
 Memory: Stores information being processed by the CPU  

Input devices: Allows people to supply information to computers  
Output devices Allows people to receive information from computers 

 

 
Computer Code: A system of signals used to represent letters or numbers in transmitting messages. The 
instructions in a computer program. Instructions written by a programmer in a programming language are 
often called source code. 
Type of computer code: 

1)  BCD CODE 



2) EBCD CODE 
3) ACIIE CODE 
4) Gray CODE 
5) Access 3 CODE 

1)BCD CODE( binary coded decimal): Binary coded decimal (BCD) is a system of writing numerals that 
assigns a four-digit binary code to each digit 0 through 9 in a decimal (base-10) numeral. The four-bit BCD code 
for any particular single base-10 digit is its representation in binary notation, as follows: 
0 = 0000 
1 = 0001 
2 = 0010 
3 = 0011 
4 = 0100 
5 = 0101 
6 = 0110 
7 = 0111 
8 = 1000 
9 = 1001 
Numbers larger than 9, having two or more digits in the decimal system, are expressed digit by digit. For example, 
the BCD rendition of the base-10 number 1895 is 
0001 1000 1001 0101 
The binary equivalents of 1, 8, 9, and 5, always in a four-digit format, go from left to right. 
The BCD representation of a number is not the same, in general, as its simple binary representation. In binary form, 
for example, the decimal quantity 1895 appears as 
11101100111 
Other bit patterns are sometimes used in BCD format to represent special characters relevant to a particular system, 
such as sign (positive or negative), error condition, or overflow condition. 
The BCD system offers relative ease of conversion between machine-readable and human-readable numerals. As 
compared to the simple binary system, however, BCD increases the circuit complexity. The BCD system is not as 
widely used today as it was a few decades ago, although some systems still employ BCD in financial applications. 
2)EBCD(Extended Binary Coded Decimal (Extended BCD)): An improvement over earlier (1950) Binary 
Coded Decimal (BCD) and (1951) Extended Binary Coded Decimal (Extended BCD), EBCDIC was developed by 
IBM in 1962 to enable different IBM computer systems to communicate based on a standard coding scheme, which 
users have the ability to modify. EBCDIC is an 8-bit coding scheme, yielding 2 8 (256) possible combinations. As a 
result, English and similarly complex alphabets can be supported, as can upper- and lowercase letters, a full range 
of numbers (09), and all necessary punctuation marks. EBCDIC also supports a large number of control characters, 
which is critical in the coordination of communications between the complex mainframe and midrange computers 
that were the core of IBM's business 
3) ASCII (American Standard Code for Information Interchange): is the most common format for text files in 
computers and on the Internet. In an ASCII file, each alphabetic, numeric, or special character is represented with a 
7-bit binary number (a string of seven 0s or 1s). 128 possible characters are defined. 
UNIX and DOS-based operating systems use ASCII for text files. Windows NT and 2000 uses a newer 
code, Unicode. IBM's S/390 systems use a proprietary 8-bit code called EBCDIC. Conversion programs allow 
different operating systems to change a file from one code to another. 
ASCII was developed by the American National Standards Institute (ANSI). 
 
4) Gray CODE: reflected binary code (RBC), also known as Gray code. he reflected binary code was originally 
designed to prevent spurious output from electromechanical switches. Today, Gray codes are widely used to 
facilitate error correction in digital communications such as digital terrestrial television and some cable 
TV systems. 

5) The Excess-3 code:- It is an important BCD code , is a 4 bit code and used with BCD numbers To convert 
any decimal numbers into its excess- 3 form ,add 3 to each decimal digit and then convert the sum to a BCD 
number As weights are not assigned, it is a kind of non weighted codes 



INPUT DEVICE: In computing, an input device is a peripheral (piece of computer hardware equipment) used to 
provide data and control signals to an information processing system such as a computer or information appliance. Examples 
of input devices include keyboards, mouse, scanners, digital cameras and joysticks 
1)Keyboard: he computer keyboard uses the same key arrangement as the mechanical and electronic typewriter 
keyboards that preceded the computer. The standard arrangement of alphabetic keys is known as the keyboard 
2) mouse: A device that controls the movement of the cursor or pointer on adisplay screen. A mouse is a 
small object you can roll along a hard, flat surface. Its name is derived from its shape, which looks a bit like a 
mouse, its connecting wire that one can imagine to be the mouse's tail, and the fact that one must make it scurry 
along a surface. 
3)Scanner: A scanner is a device that captures images from photographic prints, posters, magazine pages, and 
similar sources for computer editing and display. Scanners come in hand-held, feed-in, and flatbed types and for 
scanning black-and-white only, or color.  
4) (Optical Character Reader): OCR is the process of taking an image of letters or typed text and converting it 
into data the computer understands. A good example is companies and libraries taking physical copies of books, 
magazines, or other old printed material and using OCR to put them onto computers. While far from perfect, OCR 
is currently the best method of digitizing typed pages of text. 
5) OMR (optical mark reader):  A special scanning device that can read carefully placed pencil marks on specially 
designed documents. OMR is frequently used in forms, questionnaires, and answer-sheets.  
6) BAR CODE READER: A barcode reader (or barcode scanner) is an electronic device that can read and output 
printed barcodes to a computer. Like a flatbed scanner, it consists of a light source, a lens and a light sensor 
translating optical impulses into electrical ones. 
7) MICR (magnetic ink character recognition): Magnetic Ink Character Recognition is a character recognition 
system that uses special ink and characters. When a document that contains this ink needs to be read, it passes 
through a machine, which magnetizes the ink and then translates the magnetic information into characters. 
MICR technology is used by banks. Numbers and characters found on the bottom of checks (usually containing the 
check number, sort number, and account number) are printed using Magnetic Ink. To print Magnetic Ink need, you 
need a laser printer that accepts MICR toner. 
OUTPUT DEVICE: An output device is any device used to send data from a computer to another device or user. 
Most computer data output that is meant for humans is in the form of audio or video. Thus, most output devices 
used by humans are in these categories. Examples include monitors, projectors, speakers, headphones and printers. 
Output is mainly two type 
1) Soft Output 
2) Hard output 
Name of output device: 

1) Printer 
2) Plotter 
3) Monitor 
4) Projector  

 Storage Device :Storage Device is frequently used to mean land the devices and data connected to the computer 
through input/output operations - that is, hard disk and tape systems and other forms of storage that don't include 
computer memory and other in-computer storage. For the enterprise, the options for this kind of storage are of 
much greater variety and expense than that related to memory 
It manly two type  

1)Temporary memory: primary storage, which holds data in memory (sometimes called random access memory 
or RAM) 
RAM is manly two types: 

1. Static RAM  
2. Dynamic RAM 

 
 
 
 
 



Different between Static RAM and dynamic RAM 
 

 
2) Secondary memory:  secondary storage, which holds data on hard disks, tapes, and other devices requiring 
input/output operations. A secondary storage coconut device refers to any volatile storage device that is internal or 
external to the computer. It can be any storage device beyond the primary storage  is very high that enables permanent 
data storage. A secondary storage device is also known as an auxiliary storage device or external storage. 
a)Magnetic Tab: Magnetic  tab is most popular storage medium for large data access. magnetic tab is plastic ribbon .It 
surface has coating iron oxide, sodium dioxide. Data while magnetization magnetic tab is store in real or small cassette  

b) Magnetic disk: A magnetic disk primarily consists of a rank rotating magnetic surface and a mechanical arm that circulates 
over it. The mechanical arm is used to read from and write data to the disk. The data on a magnetic disk are read and written 
using a magnetization process. Typically, a magnetic disk is the primary storage disk in a computer. Data are organized on the 
disk in the form of tracks and sectors, where tracks are the circular divisions of the disk. 
Ex. Hard Disk,  Floppy disk 
c) Optical Disk: A optical Disk storage system consist of a plastic disk coated with a highly reflected material. It use laser 
beam technology for read, write of data from to disk  
ex. CD, DVD 
d):Flash Drive: Flash memory is non-volatile ,electrical Erasable program read only program it is highly durable solid stat 
storage device .  
ex: pen drive, memory card 
Software: software is a collection of instructions that enable the user to interact with a computer, its hardware, or 
perform tasks. Without software, computers would be useless. For example, without your Internet browser, you 
could not surf the Internet or read this page and without an operating system, the browser could not run on your 
computer software is a collection of computer program instruction procedure and the document that perform some 
task on a computer system it is divided into two part 

1) System software 
2) Application system 

  1)System software : System software is a type of computer program that is designed to run a computer’s 
hardware and application programs. If we think of the computer system as a layered model, the system software is 
the interface between the hardware and user applications. 
The operating system (OS) is the best-known example of system software. The OS manages all the other programs 
in a computer.  
Type of System software 

1) Complier2) assembeler,3) Loader 4) Linker 5) interpreter  
 

1)Complier: A program that translates source code into object code. The compiler derives its name from the way it works, 
looking at the entire piece of source code and collecting and reorganizing the instructions. Thus, a compiler differs from 
an interpreter, which analyzes and executes each line of source code in succession, without looking at the entire program. The 
advantage of interpreters is that they can execute a program immediately. Compilers require some time before an executable 
program emerges. However, programs produced by compilers run much faster than the same programs executed by an 
interpreter. Every high-level programming language (except strictly interpretive languages) comes with a compiler. In effect, 
the compiler is the language, because it defines which instructions are acceptable. 
Because compilers translate source code into object code, which is unique for each type of computer, many compilers are 
available for the same language. For example, there is a FORTRAN compiler 
2)Interpreter : In computer science, an interpreter is a computer program that directly executes, i.e. performs, instructions 
written in a programming or scripting language, without previously compiling them into a machine language program. An 
interpreter generally uses one of the following strategies for program execution: 

Sr. 
No. 

S RAM D RAM 

1 It is cheaper It is Faster 

2 It is slower It is faster 

3 It is during the working does not 
store longer data(Take the refresh) 

It is during the working store longer data(Do not Take the refresh) 

4 Storage capacity is smaller Storage capacity is longer 



1. parse the source code and perform its behavior directly. 
2. translate source code into some efficient intermediate representation and immediately execute this. 
3. explicitly execute stored precompiled code[1] made by a compiler which is part of the interpreter system. 

3)Loader: In a computer operating system , a loader is a component that locates a given program (which can be 
an application or, in some cases, part of the operating system itself) in offline storage (such as a hard disk ), loads it 
into main storage (in a personal computer, it's called random access memory ), and gives that program control of 
the computer (allows it to execute its instruction s). 
4)Linker: In computing, a linker or link editor is a computer program that takes one or more object files generated 
by a compiler and combines them into a single executable file, library file, or another object file. 
A simpler version that writes its output directly to memory is called the loader, though loading is typically 
considered a separate process. 
5)Assembler: An assembler is a type of computer program that interprets software programs written in assembly 
language into machine language, code and instructions that can be executed by a computer. 
An assembler enables software and application developers to access, operate and manage a computer's hardware 
architecture and components. 
An assembler is sometimes referred to as the compiler of assembly language. It also provides the services of an 
interpreter. 
 
Computer Language manly two type: 

1) Machine Language 
2) Assembly Language 
3) High level Language  

 
1) Machine Language: Programming language that can be directly understood and obeyed by a machine 

(computer) without conversion (translation). Different for each type of CPU, it is the native binary language 
(comprised of only two characters: 0 and 1) of the computer and is difficult to be read and understood by 
humans.  

2) Assembly Language: An assembly language contains the same instructions as a machine language, but the 
instructions and variables have names instead of being just numbers. Programs written in high-level languages are 
translated into assembly language or machine language by a compiler. Assembly language programs are translated 
into machine language by a program called an assembler. 

3) High level Language: a high-level language is a computer programming language that isn't limited by the 
computer, designed for a specific job, and is easier to understand. It is more like human language and less 
like machine language. However, for a computer to understand and run a program created with a high-level 
language, it must be compiled into machine language.  
 
Application system: Application software, or simply applications, are often called productivity programs or 
end-user programs because they enable the user to complete tasks such as creating documents, spreadsheets, 
databases, and publications, doing online research, sending email, designing graphics, running businesses, 
and even playing games! Application software is specific to the task it is designed for and can be as simple 
as a calculator application or as complex as a word processing application.  
ex.: Word processing, spread sheet, database, Presentation software etc 
 
ROM: Once data has been written onto a ROM chip, it cannot be removed and can only be 
read. ROM retains its contents even when the computer is turned off. ROM is referred to as being 
nonvolatile. 
PROM: (programmable read-only memory), a memory chip on which data can be written only once. Once 
a program has been written onto a PROM. 
EPROM: EPROM (erasable programmable read-only memory) is programmable read-only memory 
(programmable ROM) that can be erased and re-used. Erasure is caused by shining an intense ultraviolet 
light through a window that is designed into the memory chip.  

EEPROM: Electrically Erasable Programmable Read-Only Memory (EEPROM) is a stable, non-volatile memory storage 
system that is used for storing minimal data quantities in computer and electronic systems and devices, such as circuit boards. 
This data may be stored, even without a permanent power source, as device configuration or calibration tables. 



If storing higher volumes of data that is static (like in USB drives), certain types of EEPROM (like flash memory) are more 
cost-effective than conventional EEPROM devices. 

 
COMPUTER NETWORK: A group of two or more computing devices connected via a form of 
communications technology. For example, a business might use a computer network connected via cables or 
the Internet in order to gain access to a common server or to share programs, files and other information. 
1)  Peer to peer network 

       2)Client to server network 
1) Peer to peer network: a peer-to-peer (P2P) network is created when two or more PCs are connected and 
share resources without going through a separate server computer. 

 
 
2) Client to server network: A computer network diagram of clients communicating with a server via the 
Internet. The client–server model is a distributed application structure that partitions tasks or workloads 
between the providers of a resource or service, called servers, and service requesters, called clients. 

 
 

 
 
LAN:(Local Area Network)  local-area network (LAN) is a computer network that spans a relatively small area. 
Most often, a LAN is confined to a single room, building or group of buildings, however, one LAN can be 
connected to other LANs over any distance via telephone lines and radio waves. LANs 
connect workstations and personal computers. Each node (individual computer ) in a LAN has its own CPU with 
which it executes programs, but it also is able to access data and devices anywhere on the LAN. This means that 
many users can share expensive devices, such as laser printers, as well as data. Users can also use the LAN to 
communicate with each other, by sending email or engaging in chat sessions. LANs are capable of transmitting data 
at very fast rates, much faster than data can be transmitted over a telephone line; but the distances are limited and 
there is also a limit on the number of computers that can be attached to a single LAN. 
 

 



 
MAN: (metropolitan area network  ):A metropolitan area network (MAN) is a network that interconnects users 
withcomputer resources in a geographic area or region larger than that covered by even a large local 
area network (LAN) but smaller than the area covered by a wide area network (WAN). 

 
WAN (WIDE AREA NETWORK): A computer network that spans a relatively large geographical area. 
Typically, a WAN consists of two or more local-area networks (LANs). Computers connected to a wide-
area network are often connected through public networks, such as the telephone system. They can also be 
connected through leased lines or satellites. 

 
Network Topology: Network topology is the arrangement of the various elements (links, nodes, etc.) of a 
computer network. Essentially, it is the topological structure of anetwork and may be depicted physically or 
logically 

1) BUS TOPOLOGY: Bus Topology. Alternatively referred to as a line topology, a bus topology is a 
network setup in which each computer and network device are connected to a single cable or backbone. The 
following sections contain both the advantages and disadvantages of using a bus topology with your 
devices. 

 
2) RING TOPOLOGY: A ring network is a network topology in which each node connects to exactly two 

other nodes, forming a single continuous pathway for signals through each node - a ring. Data travels from 
node to node, with each node along the way handling every packet. 

 
 



3) STAR TOPLOGY: a star network, star topology is one of the most common network setups. In this 
configuration, everynode connects to a central network device, like a hub, switch, or computer. The central 
network device acts as a server and the peripheral devices act as clients. 

 
Component of computer network: 
1) Server 
2) Work station 
3) Hub 
4) Switch 
5) Cable 
6) Router 
7) Bridge 
8) Repeater 

Internet he Internet is the global system of interconnected computer networks that use the Internet protocol 
suite (TCP/IP) to link billions of devices worldwide. It is a network of networks that consists of millions of private, 
public, academic, business, and government networks of local to global scope, linked by a broad array of electronic, 
wireless, and optical networking technologies. The Internet carries an extensive range of information resources and 
services, such as the inter-linked hypertext documents and applications of the World Wide 
Web (WWW), electronic mail, newsgroups, voice over IP telephony, for file sharing. 

 
Intranet: An intranet is a private network accessible only to an organization's staff. Generally a wide 
range of information and services from the organization's internal IT systems are available that would 
not be available to the public from the Internet. A company-wide intranet can constitute an important 
focal point of internal communication and collaboration, and provide a single starting point to access 
internal and external resources. In its simplest form an intranet is established with the technologies 
for local area networks (LANs) and wide area networks (WANs). 
 
 
     UNIT II  
 

Introduction: Operating system and function, evolution of operating system, batch, interactive, time sharing 
and real time system. Single user operating system and multi-user operating system. Basics in MS-DOS, 
 internal and external commands in MS-DOS 
 
 
Operating System: An Operating System (OS) is an interface between a computer user and computer 
hardware. An operating system is a software which performs all the basic tasks like file management, 
memory management, process management, handling input and output, and controlling peripheral devices 
such as disk drives and printers. 
 
Function of Operating system: 
1) Process management 
2) Memory Management 
3) File management 
4) Device management 

 



1) Process management: 
a) Control access to share resource like file, memory, input, output and CPU 
b) Control execution of application 
c) Create, execute and delete a process 
d) Cancel and resumed a process 
e) Schedule a process  

2) Memory management:  
a) The activity of memory management handle by OS 
b) Allocate memory 
c) Free memory 
d) Reallocate memory to a program when a use 

3) File management: 
a) Create and delete both file 
b) Provide access file 
c) Allocate space for file 
d) Keep backup of file 
e) Secure file 

4) Device management 
a) Open, close and write device driver 
b) Communication, ctrl and monitor the device driver   

              Type of OS: 
1) Batch Operating System 
2) Time Shearing Operating system 

                                  3)   Real Time operating System 
4) Interactive Operating System 

 
1)Batch Operating System: The users of a batch operating system do not interact with the 
computer directly. Each user prepares his job on an off-line device like punch cards and submits it 
to the computer operator. To speed up processing, jobs with similar needs are batched together and 
run as a group. The programmers leave their programs with the operator and the operator then sorts 
the programs with similar requirements into batches. 
 
2)Time-sharing operating systems: Time-sharing is a technique which enables many people, 
located at various terminals, to use a particular computer system at the same time. Time-sharing or 
multitasking is a logical extension of multiprogramming. Processor's time which is shared among 
multiple users simultaneously is termed as time-sharing. 
Advantages of Timesharing operating systems are as follows − 
 Provides the advantage of quick response. 
 Avoids duplication of software. 
 Reduces CPU idle time. 
Disadvantages of Time-sharing operating systems are as follows − 
 Problem of reliability. 
 Question of security and integrity of user programs and data. 
 Problem of data communication. 

 
                       3)Real Time operating System 

A real-time system is defined as a data processing system in which the time interval 
required to process and respond to inputs is so small that it controls the environment. The time taken 
by the system to respond to an input and display of required updated information is termed as 
the response time. So in this method, the response time is very less as compared to online processing. 
Real-time systems are used when there are rigid time requirements on the operation of a processor or 
the flow of data and real-time systems can be used as a control device in a dedicated application. A 
real-time operating system must have well-defined, fixed time constraints, otherwise the system will 



fail. For example, Scientific experiments, medical imaging systems, industrial control systems, 
weapon systems, robots, air traffic control systems, etc. 

                     There are two types of real-time operating systems. 
                     Hard real-time systems 

Hard real-time systems guarantee that critical tasks complete on time. In hard real-time systems, 
secondary storage is limited or missing and the data is stored in ROM. In these systems, virtual 
memory is almost never found. 

                      Soft real-time systems 
Soft real-time systems are less restrictive. A critical real-time task gets priority over other tasks and 
retains the priority until it completes. Soft real-time systems have limited utility than hard real-time 
systems. For example, multimedia, virtual reality, Advanced Scientific Projects like undersea 
exploration and planetary rovers, etc. 

                     4)Interactive Systems 
                     Interactive systems are computer systems characterized by significant amounts of interaction between 
                     Humans and the computer. Most users have grown up using Macintosh or Windows computer  
                     operating systems, which are prime examples of graphical interactive systems.  

single-user operating system: 
                  A single-user operating system is a type of operating system (OS) that is developed and intended for use 
                  on a computer or similar machine that will only have a single user at any given time. This is the most  
                  common type of OS used on a home computer, as well as on computers in offices and other work  
                  environments. There are two general types of single-user systems:  
                   multi-user operating system: 
                  A multi-user operating system is a computer operating system (OS) that allows multiple users on  
                  different computers or terminals to access a single system with one OS on it. These programs are often  
                  quite complicated and must be able to properly manage the necessary tasks required by the different  
                  users connected to it. The users will typically be at terminals or computers that give them access to the  
                  system through a network, as well as other machines on the system such as printers.       
                  Single tasking:  

Single-user, single task - As the name implies, this operating system is designed to manage the computer 
so that one user can effectively do one thing at a time. The Palm OS for Palm handheld computers is a 
good example of a modern single-user, single-task operating system. 

                 Multi tasking operating system: 
A multitasking OS is able to run more than one process simultaneously and has control over which 
process is using the CPU and other resources at each time, as opposed to a cooperative multitasking OS 
where the processes had to voluntarily relinquish the CPU, leading to hangs and crashes 

Scheduling: In computing, scheduling is the method by which threads, processes or data flows are given access 
to system resources (e.g. processor time, communications bandwidth). This is usually done to load balance and 
share system resources effectively or achieve a target quality of service. 
 
MS DOS:DOS is a single user operating systems. DOS OS is a connection of program when the computer 
is switch on the file command dot.com is loaded to RAM and the successfully start the computer. 

             It have three part 
1) Resident part 
2) Initialization part 
3) Transient part 

 
                   Resident part:Most of the command program are located in resident part 
                   Initialization part:While booting the no. of file and buffer to open are contain in the Initialization part 
                   Transient part:Transient part is flaxible part of the OS command are not case sensitive 
 
 
 
 
 



Different between Internal and external command 
Sr. 
No 

Internal command External command 

1) Those command which are contain in command 
.com file of ms dos 

Those function that are 
built into the command 
interpreter 

2) internal command do not vary from system to 
system 

External  command vary 
from system to system 

3) Example of internal command is del, md,cd etc Example of external 
command is ping ,ipconfig 

 
 

UNIT III 
 

Introduction to MS-OFFICE-2007, word 2007 document creation, editing, formatting table 
handling, mail merge. Excel-2007, editing, working retrieval, important functions, short cut keys 
used in EXCEL 

Word processing software :is used to manipulate a text document, such as a resume or a report. You typically 
enter text by typing and the software provides tools for copying, deleting and various types of formatting. Some of 
the functions of word processing software include: 

 Creating, editing, saving and printing documents. 
 Copying, pasting, moving and deleting text within a document. 
 Formatting text, such as font type, bolding, underlining or italicizing. 
 Creating and editing tables. 
 Inserting elements from other software, such as illustrations or photographs. 
 Correcting spelling and grammar. 

Word processing includes a number of tools to format your pages. For example, you can organize your text into 
columns, add page numbers, insert illustrations, etc. However, word processing does not give you complete control 
over the look and feel of your document. When design becomes important, you may need to use desktop publishing 
software to give you more control over the layout of your pages. 
Advatage of Word Processing: The main advantages of Word processor over using a typewriter are as 
follows: You can make changes without retyping the entire document. You can easily correct typing mistakes. You 
can easily delete text from document. It is easy to insert a word, sentence, or paragraph in the middle (or any 
location) of a document. 
Feature of word processing: 
1)Word ,sentence can be insert ,modife or delet 
2)Pragraph or text can be move through out the document 
3) margin and page length can be adjust as design 
4)spleeing can be check and modify 
5) spleing check facility 
 
Office 2007: Suite of products developed by Microsoft Corporation that includes Microsoft Word, Excel, Access, 
Publisher, PowerPoint, and Outlook. Each program serves a different purpose and is compatible with other 
programs included in the package. The suite of programs is compatible with both the Windows and Macintosh 
operating system. Microsoft Office is the most common form of software used in the western world. 
 
MS Word 2007: Microsoft Word is a word processing program that allows for the creation of both simple and 
sophisticated documents. The program is equipped with templates and wizards to help you create useful documents 
such as resumes, letters and fax cover sheets. There are also features that allow you to add professional looking 
graphics to your documents. You will notice some obvious changes immediately after starting Word 2007. For 



starters, the top bar has a completely new look, consisting of new features, buttons and naming conventions. Don’t 
be alarmed, Word has been redesigned with a fresh new look that offers a more efficient and straight forward 
approach. What’s new in Word 2007 is outlined below. 

Part of MS Word 2007 
1. Microsoft Office Button: A button that provides access to menu commands in Word. The Microsoft Office 

Button replaces the File button in previous versions. Here is where you will find commonly known features 
such as New, Open, Save, Print and Recent Documents. This is also where you will find the Word Options 
commands that were previously located in the Tools menu in previous versions. 

2. Ribbon: An area across the top of the screen that makes almost all the capabilities of Word available in a 
single area. The Ribbon replaces the menus and toolbars in previous versions. The Ribbon exposes most of 
the features that used to be hidden in File menus. The Ribbon makes it easier to see and find commands to 
format your document. The Ribbon can be reduced to a single line of tabs by pressing CTRL + F1.  

3. Tab: An area on the Ribbon that contains buttons that are organized in groups. The default tabs are Home, 
Insert, Page Layout, Reference, Mailings, Review and View.  

4. Quick Access Toolbar: A customizable toolbar at the top of an active document. By default the Quick 
Access Toolbar displays the Save, Undo, and Repeat buttons and is used for easy access to frequently used 
commands. To customize this toolbar click on the dropdown arrow and select the commands you want to 
add. 

5. Title Bar: A horizontal bar at the top of an active document. This bar displays the name of the document 
and application. At the right end of the Title Bar is the Minimize, Restore and Close buttons.  

6. Groups Categories: A Group of buttons on a tab that are exposed and easily accessible. These buttons were 
formally embedded in menus on the Menu Bar.  

7. Dialog Box Launcher: A button that launches a dialog box containing options for refining a command.  
8. Status Bar: A horizontal bar at the bottom of an active window that gives details about the active 

document.  
9. View Toolbar: A toolbar that enables, adjusts, and displays different views of a document’s content.  
10. Zoom Button: A button that magnifies or reduces the contents in the document window. 

 
Creat a new  and opening existing  Document: 
1) Creat new doument:  

Step 1-> Click the Microsoft Office Button  
Step 2->Click New  
Step 3-> Select Blank Document  
Step 4-> Click on Create 

             2) Opening existing Document: 
Step 1->First go to the file menu bar and click on the open button and select to the existing document 
 
Editing in ms word 
1) Typing and inserting Text 
2) Selecting Text 
3) Deleting Text 

 
                Formatting Tool bar: 

1) Font Face 
2) Font size 
3) Font style 
4) Alignment 

 
              Table Handling in MS Word 2007 

1) Insert table 
Click the New File icon to create a new document if necessary. To Create a Table:  
Step 1-> Click the Insert tab on the Ribbon  
Step 2-> Click the Table button  



Step 3-> Select Insert Table  
Step 4-> Click the arrows to select the desired number of columns  
Step 5-> Click the arrows to select the desired number of rows  
Step 6-> Click OK 

2) Draw table and modified a table 
To Insert a Row:  
1) Position the cursor in the table where you would like to insert a row  
2) Select the Layout tab on the Ribbon  
3) Click either the Insert Row Above or the Insert Row Below button in the Rows & Columns group To 
Insert a Column  
1) Position the cursor in the table where you would like to insert a column  
2) Select the Layout tab on the Ribbon  
3) Click either the Insert Columns to Left button or the Insert Columns to Right button in the Rows & 
Columns group  
To Delete a Row  
1) Position your cursor in the row that you would like to delete 
 2) Select the Layout tab on the Ribbon  
3) Click the Delete button in the Rows & Column group 
 4) Select Delete Rows  
To Delete a Column 
 1) Position your cursor in the column that you would like to delete  
2) Select the Layout tab on the Ribbon 
 3) Click the Delete button in the Rows & Column group  
4) Select Delete Columns 
 
Header and footer in MS word 2007: Headers and footers are areas in the top, bottom, and side 
margins of each page in a document. You can customize either or choose to use a built-in style from the 
gallery. You also can add much more besides page numbers to your headers or footers. 
Create the header and footer: 

1) Choose Insert, and then choose either Header or Footer. 

 

2) Dozens of built-in layouts appear. Scroll through them and choose the one you want.The header and 
footer space will open in your document, along with the Header & Footer Tools. You won’t be able to 
edit the body of your document again until you close the Header & Footer Tools. 

3) Type the text you want in the header or footer. Most headers and footers have placeholder text (such as 
 "Document title") that you can type right over. 

              4)When you're done, choose Close Header and Footer. 
 

           Mail Merge: Mail Merge is a powerful tool for writing and sending a personalized letter or e-mail to 
many different people at the same time. You can also use it to create envelopes or labels with each recipient' 
information. Mail Merge imports data from another source such as Excel and then uses that data to replace 
placeholders throughout your message with the relevant information for each individual you are messaging. You 
can use it to quickly create personalized messages for hundreds of people at once. 
 
 



MS EXCEL 2007 
 
  Spread sheet: A spreadsheet is a sheet of paper that shows accounting or other data in rows and columns; a 
spreadsheet is also a computer application program that simulates a physical spreadsheet by capturing, displaying, 
and manipulating data arranged in rows and columns. The spreadsheet is one of the most popular uses of the 
personal computer. In a spreadsheet, spaces that hold items of data are called cells. Each cell is labeled according to 
its placement (for example, A1, A2, A3...) and may have an absolute or relative reference to the cells around it. A 
spreadsheet is generally designed to hold numerical data and short text strings. Spreadsheets usually provide the 
ability to portray data relationships graphically. Spreadsheets generally do not offer the ability to structure and label 
data items as fully as a database and usually do not offer the ability to query the database. In general, a spreadsheet 
is a much simpler program than a database program. 
Ex: Lotus 1,2,3and ms excel 
MS Excel 2007: Microsoft Excel is a spreadsheet program included in the Microsoft Office suite of applications. 
Spreadsheets present tables of values arranged in rows and columns that can be manipulated mathematically using 
both basic and complex arithmetic operations and functions. 
 
Editing the work sheet: 

1) Moving through cell: Use the mouse to select a cell you want to begin adding data to and use the 
keyboard strokes the allocated key 

2) Adding worksheet, row and columns: 
a) Worksheet: Add a worksheet to a workbook by selecting insert/worksheet from the menu bar 
b) Row: To add a row to a worksheet, select insert/row from the menu bar, or highlight the row by 
clicking on the row label, right click with the mouse, and choose insert  
c)Column: Add a column by selecting Insert/Columns from the menu bar,or highlight the column by 
click on the column by click on the column label ,right-click with the mouse and choose insert 
Formula and Function in ms excel 2007: 

Formula: A formula is an expression which calculates the value of a cell.  

For example, cell A3 below contains a formula which adds the value of cell A2 to the value of cell A1. 

 

Enter a Formula 
To enter a formula, execute the following steps. 

1. Select a cell. 

2. To let Excel know that you want to enter a formula, type an equal sign (=). 

3. For example, type the formula A1+A2. 



 

Tip: instead of typing A1 and A2, simply select cell A1 and cell A2. 

4. Change the value of cell A1 to 3. 

 

Excel automatically recalculates the value of cell A3. This is one of Excel's most powerful features! 

 

Function: Functions are predefined formulas and are already available in Excel. 
For example, cell A3 below contains the SUM function which calculates the sum of the range A1:A2. 

 

Edit a Formula 
When you select a cell, Excel shows the value or formula of the cell in the formula bar. 

 

1. To edit a formula, click in the formula bar and change the formula. 



 

2. Press Enter. 

 

MS-Excel Shortcut: 

1. Ctrl+W. Close the active window / document. 
2. Ctrl+Z. Undo an action. 
3. Ctrl+Y. Redo the last action or repeat an action. 
4. Ctrl+S. Save a document. 
5. Ctrl+P. Print a document. 
6. Ctrl+K. Insert a hyperlink. 
7. Alt+Left. Arrow Go back one page. 
8. Alt+Right. Arrow Go forward one page 

9. Ctrl+W. Close the active window / document. 
10. Ctrl+Z.  Undo an action. 
11. Ctrl+Y. Redo the last action or repeat an action. 
12. Ctrl+S. Save a document. 
13. Ctrl+P. Print a document. 
14. Ctrl+K. Insert a hyperlink. 
15. Alt+Left. Arrow Go back one page. 
16. Alt+Right. Arrow Go forward one page. 
17. Ctrl+C. Copy selected text or graphics to the Office Clipboard. 
18. Ctrl+V. Paste the most recent addition to the Office Clipboard. 
19. Ctrl+Shift+A. Format all letters as capitals. 
20. Ctrl+B. Applies or removes bold formatting. 
21. Ctrl+I. Applies or removes italic formatting. 
22. Ctrl+=. Apply subscript formatting (automatic spacing). 

 

 

 



Pivot table: Excel can help you by recommending and then automatically creating PivotTables, which are a great 
way to summarize, analyze, explore, and present your data. Excel Pivot Tables are tables that summarise large 
amounts of data in an Excel spreadsheet 

 
UNIT IV 

 
MS-Power point 2007-Job Profile, elements of Power point , ways of delivering presentation, concept of 
Four P’s (planning, preparation, practice and presentation) ways of handling presentations, e.g. creating, 
saving slides show controls, adding formatting, animation and multimedia effects. 

 

MS-Power point 2007: Power Point is the powerful and ubiquitous presentation program from Microsoft. It 
gives you the facility to create stunning presentations that incorporate video and PowerPoint animations. The image 
editing capabilities that PowerPoint offer get better and better with every new version. Starting to learn Microsoft 
PowerPoint can seem like a daunting task if you are not familiar with its environment. 

Adding New Slides To A PowerPoint Presentation: 
Once you have selected a slide, click Home > Slides > New Slide. You'll notice that the New Slide 
button is in two halves. 

 
If you click the top half of the New Slide button, the default Title and Content type slide will be 
added. If, instead, you click the bottom half of the button, you will be able to select what type of 
slide is added. 

 



PowerPoint allows users to add text to the slide in a well-defined manner to ensure the content is 
well distributed and easy to read. The procedure to add the text in a PowerPoint slide is always the 
same - just click in the text box and start typing. The text will follow the default formatting set for 
the text box, although this formatting can be changed later as required. What changes is the 
different kinds of content boxes that support text in a PowerPoint slide. Given below are some of 
the most common content blocks you will see in PowerPoint. 

Title Box 
This is typically found on slides with title layout and in all the slides that have a title box in them. 
This box is indicated by "Click to add title" 

 

Subtitle Box 
This is found only in slides with Title layout. This is indicated by "Click to add subtitle" 

Content Box 
This is found in most of the slides that have a placeholder for adding content. This is indicated by 
"Click to add text". As you can see, this box allows you to add text as well as non-text content. 
To add text to such a box, click anywhere on the box, except on one of the content icons in the 
center and start typing. 

 



Text Only Box 
This is not a default content box available in PowerPoint, but you can create it using Slide Master, 
if required. This is also indicated by "Click to add text". The only difference between Text Only 
Box and the Content box is that former only supports text in the content area. 

Concept of 4 p: 
1) Planning 
2) Preparation 
3) Practice 
4) Presentation 
 
        1)Planning: Planning means the process of setting goal, developing strategies and outlining task and 
schedules to accomplish the goals. 
2) Preparation: preparation means state of making something ready for use.preparations are typically done in 
anticipation of event occurring in the near future. 
3) Practice: Practice means frequently repeated or customary action; habitual performance; a succession of acts of 
a similar kind. 
4) Presentation: Presentation is the practice of showing and explaining the content of a topic to an audience or 
learner 
Multimedia Effects: 
Power point also lest you attach sounds to different object on a slide. However the object must be animated before 
you can attach a sound a file 
a) Adding sound from a file 
b) Recording your own sound files 
c) Adding music   
 

Unit V 

Computer applications in pharmaceutical and clinical studies, uses of internet in pharmaceutical industry. 

Uses of computer in in pharmaceutical and clinical studies: 
a)Hospital Administration: 
Hospital is an important Organization. You can use computer for the administration of a hospital. 
You can computerize the accounting, payroll and stock system of the hospital. you can keep the 
record of the different medicines, their distribution and use in different ward etc.  
b) Recording Medical History: Computer can be used to store the medical history of the patients. 
We can store the important facts about the patients in computer 
c) Life support System: Life support System are used to help the disable persons .Many devices 
are used that help deaf person to hear. Scientists are trying to create device that will help he blind 
person to see. 
d) Diagnosis of Diseases: Different software are available that store different diseases and their 
symptoms. Diagnosis of disease is possible by entering the symptoms of a patient. Moreover 
different computerized devices are used in laboratories for different test of blood etc. 
e) Buying Drugs online: Shopping over the internet is private and easy. Online drug stores let you 
shop for medicine from your computer.  
uses of internet in pharmaceutical industry: 
 a) Computer and Internet Connection 
 b) Credit card 
 c) Email Account 



 d)Domain Name 
 e)Web Hosting 
 f)Web site 
Some computer term Use in pharmaceutical  
         a) Telemedicine: The idea behind telemedicine is that if a doctor or specialist 
             can see a patient via video or computer links, and then they can provide 
             diagnosis and help to people in remote place, or when it is not practical move  
              the patients 

b)Electronic Patient Record: Electronic Patient Record have to some extent 
been used in medicine for many years. With the increasing presence of computer 
at home and  at work, there is a great deal of scope for the development of 
electronic patients records.  
c)NHSnet: The NHSnet is a scheme to link together hospital, doctors, nurses and 
pharmacies with internet providing email and web browsing without 
compromising security 


